# Table of Contents

Product Overview ............................................................................................................................................................. 5

About Resource Planning ............................................................................................................................................. 33

About Performance Manager ......................................................................................................................................... 5

About the Console .......................................................................................................................................................... 6

Key Benefits ................................................................................................................................................................. 10

Features ....................................................................................................................................................................... 10

Service Packs ............................................................................................................................................................. 14

Installing Service Packs ............................................................................................................................................ 14

Rolling Back Service Packs ...................................................................................................................................... 15

Licensing ....................................................................................................................................................................... 16

About the Licensing Console ....................................................................................................................................... 16

Managing Licenses ...................................................................................................................................................... 16

Export License Files .................................................................................................................................................... 17

Import License Files ................................................................................................................................................... 18

Troubleshooting ......................................................................................................................................................... 18

Managing Configurations .......................................................................................................................................... 19

About Configuration Files ......................................................................................................................................... 19

Open, Save and Export Configurations .................................................................................................................... 20

Preset Configurations ................................................................................................................................................ 21

Using System Center Configuration Manager for Configurations ...................................................................... 22

Configuration Profiler ............................................................................................................................................... 23

Resolve Configuration Violations ............................................................................................................................ 25

Feature Options .......................................................................................................................................................... 26

Feature Usage ............................................................................................................................................................ 26

Application Memory ................................................................................................................................................... 26

User Memory ............................................................................................................................................................. 26

Excluded Applications .............................................................................................................................................. 27

Multi-process Applications ....................................................................................................................................... 27

General ....................................................................................................................................................................... 27

Application Groups .................................................................................................................................................... 28

Create Application Groups Manually ......................................................................................................................... 28

Create Application Groups Using Application Discovery ..................................................................................... 30

Resource Planning ...................................................................................................................................................... 33

About Resource Planning ......................................................................................................................................... 33

Evaluation Order ........................................................................................................................................................ 33
Product Overview

AppSense Performance Manager allows valuable system resources to be monitored and controlled. Rules can be implemented to precisely manage the allocation and distribution of CPU, memory and disk resources for applications and users on a system. Performance Manager includes automated application memory optimization to reduce page file usage and CPU thread throttling to control demand of resources and ensure the efficient and smooth running of the system.

Performance Manager provides a fine level of granular management by allowing you to allocate resources based on the state of the session, applications or the desktop.

About Performance Manager

Use Performance Manager to tune the following resources:

- **CPU** - Processor usage can be tuned in a number of ways to ensure the optimal CPU usage and guarantee maximum user responsiveness of the computer. As well as implementing limits to application usage, guaranteed CPU values may be set to ensure that mission critical applications will always run at maximum speed, forsaking other less important applications. In addition to this, Performance Manager is able to deal with not only problem applications but also unknown and unpredictable issues, where CPU control may be implemented independently of any application.

- **Memory** - Memory usage can be addressed in a number of ways to provide flexible use. Performance Manager is able to address issues with virtual memory, Physical Memory, and the page file. Memory elements need to be managed to ensure the maximum amount is made available to new and already running applications.

  Applications are rarely written with memory usage in mind. Many collisions of application components occur in normal usage. The optimizer component of Performance Manager is able to identify and cure these collisions providing reduced usage of virtual memory, and in a multi-user system this can be translated directly into increased capacity and performance.

- **Disk** - Disk usage can be controlled to provide greater or lesser priority to specific Application Groups or User Groups.
About the Console

The Performance Manager Console launches when the link is selected in:

**Start > Programs > AppSense > Performance Manager.**

Application Menu

The Application menu provides options for managing configurations including New, Open, Save, Import & Export, and Print.

The Preferences option allows you to set basic behavior settings, including:

- Open last configuration by default
- Show splash screen on startup

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New</strong></td>
<td>Creates a new default configuration which is locked for editing.</td>
</tr>
</tbody>
</table>
| **Open** | Opens an existing configuration from one of the following locations:  
- Live configuration on this computer  
- Live configuration on remote computer  
- Configuration from the Management Center  
- Configuration in System Center Configuration Manager  
- Configuration file from disk  
You must open a live configuration to view Optimization reports. A live configuration is located on a computer which has a Performance Manager agent installed and running. |
| **Save** | Saves the configuration in one of the following states:  
- Save and continue editing  
- Save and unlock - save the configuration and unlock it ready for deployment. The current configuration closes and a new default configuration opens.  
- Unlock without saving - unlock the configuration without saving changes. The current configuration closes and a new default configuration opens. |
<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save As</strong></td>
<td>Saves the configuration with a new name to one of the following locations:</td>
</tr>
<tr>
<td></td>
<td>• Live configuration on this computer</td>
</tr>
<tr>
<td></td>
<td>• Configuration in the Management Center. The current configuration closes and a new default configuration opens</td>
</tr>
<tr>
<td></td>
<td>• Configuration in System Center Configuration Manager</td>
</tr>
<tr>
<td></td>
<td>• Configuration file on disk</td>
</tr>
<tr>
<td></td>
<td>A live configuration is located on a computer which has a Performance Manager Agent installed and running.</td>
</tr>
<tr>
<td><strong>Import &amp; Export</strong></td>
<td>• Imports a configuration from MSI format, usually legacy configurations which have been exported and saved from legacy consoles.</td>
</tr>
<tr>
<td></td>
<td>• Exports a configuration to MSI format.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Enabled with older versions of the software.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Closes the console. You are prompted to save any changes you have made to the current configuration</td>
</tr>
<tr>
<td><strong>Preferences</strong></td>
<td>Launches the Console Preferences dialog which includes:</td>
</tr>
<tr>
<td></td>
<td>• Show the Getting Started dialog on startup - selected by default</td>
</tr>
<tr>
<td></td>
<td>• Open last configuration</td>
</tr>
<tr>
<td></td>
<td>• Show splash screen on startup</td>
</tr>
</tbody>
</table>
Quick Access Toolbar

The Quick Access toolbar provides quick functionality for managing the configuration setup, such as Save, Save and Unlock, Undo, Redo, and navigation to previously and next displayed views.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves changes to the configuration. The configuration will remain locked if opened from the AppSense Management Center.</td>
</tr>
<tr>
<td>Save and unlock</td>
<td>Saves changes and unlocks the configuration. These changes can now be deployed from the Management Center.</td>
</tr>
<tr>
<td>Undo</td>
<td>Clears the action history. Up to 20 previous actions are listed. Select the point at which you want to clear the actions. The action selected and all proceeding actions are undone.</td>
</tr>
<tr>
<td>Redo</td>
<td>Re-applies the cleared action history. Up to 20 cleared actions are listed. Select the point at which you want to redo the actions. The action selected and all subsequent actions are redone.</td>
</tr>
<tr>
<td>Back</td>
<td>Navigates back through the views visited in this session.</td>
</tr>
<tr>
<td>Forward</td>
<td>Navigates forward through the views visited this session.</td>
</tr>
</tbody>
</table>

Managing the Quick Access Toolbar

You can configure the Quick Access toolbar to display the commands you use the most and to change its position in the console:

- To add a command to the Quick Access Toolbar, right-click the ribbon button or file menu option and select Add to Quick Access Toolbar.
- To remove a toolbar item, right-click it and select Remove From Quick Access Toolbar.
- To display the toolbar below a ribbon, right-click a ribbon or the toolbar and select Show Quick Access Toolbar Below the Ribbon.
Ribbons

Ribbons include buttons for performing common actions arranged in ribbon groups according to the area of the Console to which the actions relate. For example, the Home ribbon page includes all common tasks, such as Cut, Copy and Paste, Auditing, Configuration Profiler, Help, AppSense website and Support links.

Split ribbon buttons contain multiple options and are indicated by an arrow just below the button. Click the arrow to display and select the list of options, or click the button for the default action.

Help

The Home ribbon includes a Help button which launches the Help for the product and displays the topic relating to the current area of the console in view. A smaller icon for launching the Help displays at the far right of the console, level with the ribbon page tabs, for convenience when the Home ribbon page is not in view. You can also press F1 to launch the Help topic for the current view.

Navigation Pane

The Navigation pane consists of the navigation tree and navigation buttons. The navigation tree is the area for managing nodes of the configuration. The navigation buttons allow you to view the different areas of the console.

Work Area

The Work Area provides the main area for managing the settings of the configuration and product. The contents of the work area vary according to the selected nodes in the navigation tree and the selected navigation buttons. Sometimes the work area is split into two panes. For example, one pane provides a summary of the settings in the other pane.

Additional Console Features

- Shortcut menu — right-click shortcuts are available in the navigation tree and some areas of the Console.
- Drag and Drop — this feature is available in some nodes of the navigation tree.
- Cut/Copy/Paste — these actions can be performed using the buttons in the Home ribbon, shortcut menu options and also using keyboard shortcuts.
- Recommended screen resolution for the Console is 1024 x 768 pixels.
Key Benefits

The key benefits of using Performance Manager are as follows:

- Prevents CPU and memory bottlenecks.
- Delivers consistent quality of service by providing proactive resource management to guarantee resources for business critical applications and users and limiting resources to non-critical business applications and users.
- Increases user productivity and acceptance.
- Ensures predictable service levels.
- Helps drive consolidation of hardware.

Features

Application and Process Discovery

Application Discovery allows you to automatically populate Application Groups with Desktop Applications, Services or 16-bit Applications. You can select items to include in an Application Group from the results of a discovery, which are displayed in categories based on application type.

- Desktop Applications discovers Installed Applications, Running Processes and File Types.
- Services discovers Installed Applications and Services.
- 16-bit Applications discovers 16-bit Applications by searching running NTVDM services for the specified 16-bit applications to run as if they were executed on a DOS machine) services for the specified 16-bit applications.

**Note**
64-bit Windows operating systems do not support 16-bit applications.

Application Groups

Application Groups are groups of Desktop Applications, Services or 16-bit Applications. You can define Application Groups to create custom lists of applications which you assign to rules for managing the demand on CPU, memory or resources. The groups indicate specific files or folder names, and path and command line attributes with pattern matching, using wildcards and regular expressions.

Desktop Applications, services or 16-bit applications can be collated to create Application Groups which can be automatically populated using the Application Discovery function.
User Groups

User Groups are a generic way to refer to a single Windows user account or Windows Group within the Performance Manager console. As an Administrator you can use one or more User Groups to customize the way Performance Manager is deployed across your network.

Conditions

Use Conditions to define criteria for when resources are allocated to applications or users. Conditions depend on a match with the state of the window, session or desktop, or combinations of each.

CPU Resource Management

CPU Management controls the distribution of CPU resources to applications and users on the system, and includes the following:

- Share Factors – Allocate relative proportions of the CPU resources to applications and users. Share factors ensure optimum performance at peak load and continuously regulate the fair distribution of available processor resources.

- Reservations – Ensure that certain applications and users are guaranteed specific levels of CPU resources, as the need arises. At times of peak demand on the system, the minimum reserved resources are obtained and the remaining resources are reallocated according to share factors allocated to other applications.

- Limits – Prevent certain applications and users exceeding specific levels of CPU capacity when others demand their share. CPU intensive use can be managed by Hard Limits or Soft Limits. Hard limits are fixed proportions of the processor load beyond which applications and users cannot exceed even when spare capacity is available. Soft limits are more flexible and only confine applications and users within certain levels during peak load to free up resources. When general demand falls back again and resources are released, controlled applications and users can exceed limits and resume more CPU intensive activity.

- CPU Affinity – Assigns Application Groups and User Groups to specific CPUs when operating on multiprocessor servers.

- Thread Throttling – Patented technology which dynamically clamps processor intensive tasks when CPU load is too heavy whilst including flexible settings for modifying thresholds and ranges.
Memory Management

Memory Management controls the distribution of memory resources on the system and includes the following:

- **Hard Limits** - Are always imposed and used to define proportions of the processor load beyond which applications and users cannot exceed even when spare capacity is available.
- **Soft Limits** - Are less rigid than Hard Limits and only confine applications and users within certain levels during peak load to free up resources.
- **Application (Virtual) Memory Limits** – Sets limits on memory use on a per application basis and allows you to close or terminate applications when allocated memory limits are exceeded. The Close option generates a prompt to the user to close an application after the specified period. The Terminate option forces the application to stop after the specified period.
  
  **Note**
  The Terminate option will result in the loss of data for the application being terminated.
- **Physical Memory Limits** – Sets limits on the use of physical memory by applications. Minimum limits guarantee adequate resources are available ensuring applications function correctly. Maximum limits prevent resource intensive applications from causing congestion on the system.

  You can also select application memory trimming to reduce unnecessary consumption at process startup and when the state of the application window, user session or desktop changes.
- **User Memory** – Sets per-user limits for the aggregate usage of a person’s running processes. Warning and blocking messages notify the user when levels are reached or exceeded. A blocking action prevents User Applications and User Processes from launching until the user reduces memory consumption by freeing up resources or closing a running application. A list can be maintained of applications exempt from blocking actions.

Memory Optimizer

Memory Optimizer dynamically analyzes application sets and Microsoft Windows libraries, such as DLLs and OCXs and optimizes the memory utilization of each component. This is set up to run by default. You can view and configure reports and perform manual analysis using Optimizer Monitor.

Licensing

Use the AppSense DesktopNow Licensing console to manage the licenses for your Performance Manager installation.

Auditing

The Auditing node is used to configure event logging. Settings allow you to specify where to log events and which events to include in the audit. Auditing can also be managed in the AppSense Management Center.
Configuration Profiler

The Home tab includes the Configuration Profiler option for displaying a summary report of the Performance Manager configuration rules. The reports can be used to analyze configurations before implementing them on a live system.

The Configuration Profiler report includes the details of Feature Options, Application Groups, Resource Planning, Memory Optimizer and Thread Throttling.

Working in Passive Mode

Each of the Performance Manager configuration settings can be optionally set to monitor performance control actions affecting processor and memory utilization before you commit to the policies for taking corrective action.

In Passive mode, auditing data continues being recorded, when enabled in the configuration, except for CPU Share Factors, Reservations and Soft limits.

You can apply Passive Mode to each feature using the Feature Options dialog which you access by selecting Options on the Resources Setup ribbon. You can also include or exclude system processes for certain features in this dialog.

Disk Management

Disk resource allocations assign priorities to applications and users for accessing the disk to perform read and write actions. Disk priorities range from unlimited access with no delays to lowest priority settings with large delays when demand is high.
Service Packs

AppSense Service Packs are self-contained packages or patches that are used to update specific files within a DesktopNow application without reinstalling the full application. Service packs can be applied more often and reduce the need for system restarts on your endpoints. Service packs are delivered as a Windows Installer patch (MSP) file and are often referred to as patch files.

Installing Service Packs

Service Packs can be installed or deployed using the same technology and techniques used when installing MSIs. Both Microsoft System Center and the AppSense Management Center 8 FR4 or later can deploy MSPs. If neither of these products are available, service packs can be installed using the command line interface.

For example, the command:

```
msiexec.exe /p PerformanceManagerAgent64.msp
```

installs any files that have been amended as part of the patch for just Performance Manager 64 bit agent.

The following command installs the base version of the Performance Manager Agent (MSI) and the Performance Manager patch file (MSP) simultaneously:

```
msiexec.exe /i PerformanceManagerAgent64.msi
PATCH=c:\fullpath\PerformanceManagerAgent64.msp
```

**Note**

A base version must be installed before the patch file can be applied.

If the patch file contains driver or hook files that are currently in use on the machine the patch is being applied to, you are informed that a reboot is required. If you chose to continue, the system is restarted when the patch has been applied.

For information on installing and upgrading service packs using Management Center, see the AppSense Management Center help.

Installation Order and Dependencies

It is recommended that all components of a service pack are installed.
Rolling Back Service Packs

There are two ways to roll back, or uninstall AppSense Service Packs:

- Using the Windows Control Panel Programs and Features.
- Using Management Center 8 FR4 or later

Rolling Back Service Packs Using Management Center 8 FR4 or Later

1. In the Management Center console, select Overview > Deployment Groups tab > Deployment Groups.

2. Highlight the Deployment Group and select Settings > Assigned Packages.
   The Assigned Packages work area displays a list of all the AppSense products and their associated packages.

3. Highlight the required Application Manager service pack and click Unassign from the Actions menu.

4. Click Review and Submit.
   The Submit Changes dialog displays.

5. Check the details are correct and click Submit.
   The patch is unassigned based on the deployment group Installation Schedule.
Licensing

About the Licensing Console

AppSense DesktopNow Licensing console allows you to manage AppSense DesktopNow product licenses.

The Licensing console allows you to:

- Manage licenses for single products, the AppSense DesktopNow Suite and Evaluation licenses.
- Export license packages to MSI or LIC file format for saving to the AppSense Management Center or other computers which can be remotely accessed.
- Import and manage licenses from LIC file format.

For information about license deployment to endpoints, see Management Center Help.

Managing Licenses

License details are included in the License Agreement which is issued when an order for AppSense software has been completed.

The License Agreement includes the following information:

- Product, Feature, and Version Details
- Issue Date
- Expiry Date
- Customer Name
- Serial ID

Together with the license agreement you will receive either a TXT file or a LIC file. Use these in the AppSense Licensing Console to add or import the license.

Add a License

1. Open the AppSense Licensing console.
2. Click Add.
   The Add License Key dialog displays.
3. Enter the License Key and click Add.
   If you received a TXT file from AppSense, open the file and copy the license key, paste it in to the Add License Key dialog.
   If you received a LIC file from AppSense, refer to Import License Files.

Details of the license are displayed in the console and the license key is added to the following location:

%ALLUSERSPROFILE%\AppSense\Licenses
Activate a License

Once added, some licenses require activating.

1. Select a license or add one to the licensing console.
2. Click **Activate**.
3. Type or copy and paste the activation code.
4. Press **Enter** to accept the code.
5. The license console saves the license key to the MS Windows registry on the local machine. The License Status field updates to show the status of the license and the license details display in the lower part of the console.

**Note**
To check that the license is active on your endpoint, search the registry for the license code. If the search finds the code, then the license is active.

Remove a License

1. Highlight the required license and click **Remove**.
   A confirmation dialog displays.
2. Click **Yes** to confirm.
   The selected license is deleted and removed from the console and the MS Windows registry.

Export License Files

Export licenses to an MSI or LIC file to create a backup and enable distribution to other endpoints using the Licensing console or the Management Center.

1. Highlight the license you want to export.
2. Click **Export** to display Windows Save As dialog.
3. Browse to the required location to save the license file.
4. Enter a name for the file.
5. Select the file type: MSI or LIC.
6. Click **Save**.

A file is created and saved in the selected location. This file can be copied to any network location and loaded via the AppSense DesktopNow Suite Licensing console or in the Management Center console.
Import License Files

Import a previously exported license to an endpoint using the Licensing console.

1. Open the AppSense Licensing console.
2. Click **Import** to display the Windows Open dialog.
3. Navigate to the required LIC file.
4. Click **Open**.

Details of the license are displayed in the console and the license key is added to the following location:

%ALLUSERSPROFILE%\AppSense\Licenses

Troubleshooting

I received an AppSense license, what do I do?

If you have received an AppSense product license you can load the license by launching the AppSense DesktopNow Suite Licensing Console on your client computer and entering the license code.

I have entered an AppSense license, but it says it is not activated, why?

Some AppSense licenses require activation before they can be used. Activation codes are provided by AppSense. Activate a license by entering the License and Activation codes into the console.
Managing Configurations

This section provides details about managing configurations in AppSense Performance Manager.

About Configuration Files

Performance Manager configuration files (APMP files) contain the policies for managing performance and resources on an endpoint. The Performance Manager Agent checks the rules contained within the configuration to determine the actions to take for managing performance.

Configurations are stored locally in %PROGRAMDATA%\AppSense\Performance Manager.

In Standalone mode, configuration changes are written directly to the local APMP file from the Performance Manager console. In Enterprise mode, configurations are created and stored centrally in the AppSense Management Centre database and distributed to endpoints in MSI format.

Configurations can also be exported and imported to and from MSI format, which is useful for creating templates or distributing configurations using third party deployment systems.
Open, Save and Export Configurations

The **File** menu, in the top left-hand corner of the console, allows configurations to be opened, saved, imported and exported. Application Manager saves configurations in APMP (AppSense Performance Manager Package) file format. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New</strong></td>
<td>Creates a new default configuration which is locked for editing.</td>
</tr>
</tbody>
</table>
| **Open**    | Opens an existing APMP configuration file for editing from one of the following locations:  
  - Live configuration on this computer.  
  - Configuration from the Management Center.  
  - Configuration from System Center Configuration Manager.  
  - Configuration file from disk. |
| **Save**    | The Save options are specific to the use of the configuration with the AppSense Management Center:  
  - **Save and continue editing** - Saves the configuration and keeps it locked whilst open for editing. Configurations cannot be deployed whilst locked.  
  - **Save and unlock** - Saves the configuration and unlocks it to allow deployment. The current configuration closes and a new default configuration opens.  
  - **Unlock without saving** - Unlocks the configuration without saving any changes made. The current configuration closes and a new default configuration opens. |
| **Save As** | Saves the configuration with a new name to one of the following locations:  
  - **Live configuration on this computer** - Save the current configuration on the current computer and apply it as the working configuration.  
  - **Configuration in the Management Center** - Creates the current configuration in the package store on the selected Management Center.  
  - **Configuration in System Center Configuration Manager** - Saves your configuration to the specified System Center Configuration Manager server.  
  - **Configuration file on disk** - Saves the current configuration as a file on a local or network drive in APMP format. |
| **Import and Export** |  
  - **Import configurations from MSI** - Imports a configuration from an existing MSI package, for example, legacy configurations which have been exported and saved from legacy Consoles.  
  - **Export configuration as MSI** - Exports the current configuration as an MSI package. |
Preset Configurations

When the Performance Manager Console is opened or a new configuration is created, preset configurations are available to cater for most types of environments. If the presets do not meet the requirements of your environment, configurations can be created manually.

The following preset configurations are available:

- **General Purpose** - This configuration is optimized for general purpose use. It configures Thread Throttling for non-system processes and CPU priority is given to system processes. Memory Optimizer is scheduled to run daily.

- **Physical Desktop** - This configuration is optimized for use on physical desktops. It configures Thread Throttling for all system and non-system processes and CPU priority is given to system processes. Memory Optimizer is disabled.

- **Terminal Services / Remote Desktop Services (RDS)** - This configuration is optimized for use on Terminal Services and Citrix XenDesktop environments. It configures Thread Throttling for all system and non-system processes. CPU Reservations, Application Memory Limits, Physical Memory Control and User Memory Control are enabled. Memory Optimizer is disabled.

- **Virtual Desktop Infrastructure (VDI)** - This configuration is optimized for use on VDI environments. It configures Thread Throttling for all system and non-system processes. CPU Reservations, Application Memory Limits, Physical Memory Control and User Memory Control are enabled. Memory Optimizer is disabled.
Using System Center Configuration Manager for Configurations

System Center Configuration Manager (SCCM) is a systems management software product by Microsoft for managing large groups of Windows-based computer systems. Configuration Manager provides the following:

- Remote control
- Patch management
- Software distribution
- Operating system deployment
- Network access protection
- Hardware and software inventory

For more information on System Center Configuration Manager, see Configuration Manager. AppSense Performance Manager allows configurations to be opened and saved using System Center Configuration Manager version 2012 onwards.

Connect to the System Center Configuration Manager Server

When opening or saving a configuration to SCCM, a dialog displays and allows you to connect to a System Center Configuration Manager Server and maintain a list of servers.

The following settings are available:

- **New Server** – Click to add a new server to the list by providing details in the Add System Center Configuration Manager Server dialog, including friendly name, server name (computer name or IP address). Use the Location field to specify the network location to be used to store your configuration files. The configuration location should be readable for the users who are to view the configuration or writable for those users who will be saving configurations.

- **Edit Server** – Click to edit a listed server by providing details in the Edit Server dialog, including, friendly name, server name and edit the location that your configuration are to be stored on your network.

- **Delete Server** – Remove the highlighted server from the list.

Highlight the server you want to connect to, click Connect and provide credentials for connecting to the selected server, either using the currently connected user account or a custom user. You can browse for a user on the active directory or local network, provide a password and, where appropriate, the domain.

**Note**
To use SCCM remotely, some additional configuration is required. For further information, see Configure DCOM Permissions for Remote Configuration Manager Console Connections.
Configuration Profiler

The Configuration Profiler, available from the Home ribbon, allows administrators to produce detailed reports on configurations. This can be done whether they are stored locally or centrally. The reports can be a general study of the overall configuration or can be aimed at how it interacts with a specific user, group of users or specific file.

This section provides details about the reports generated by the Configuration Profiler, and includes the following:

Report Type

The configuration profiler allows you to report on the configuration currently open in the console. General reports are produced to assist auditing and compliance such as Sarbanes Oxley or HIPAA. You can produce custom reports to assist in troubleshooting large configurations.

The configuration profiler is a reporting tool that can be used to generate quick reports based on the details of a product configuration which is currently open. The report can be generated in the following ways:

- Complete Report – produces a report which includes all aspects of the configuration.
- Report based on specific criteria – produces a report based on the specified criteria as selected in the Report Criteria section.

**Note**
Enter an asterisk (*) as the criterion value to see all actions controlled by a particular type of condition.

Report Criteria

Use the criteria to specify what is to be included in the report.

Enter the value or select an option to match for any of the following:

- User/Group – enter the name of a user or user group you wish to include in the report.
- Application – enter the name of an application you wish to include in the report.
- Application Group – select an application group to include in the report or select the asterisk (*) to produce output for all groups.
- CPU – select Include or Exclude to show or hide CPU settings in the report.
- Memory – select Include or Exclude to show or hide Memory settings in the report.
- Disk – select Include or Exclude to show or hide Disk settings in the report.

**Note**
The User/Group and Application fields support wildcard character matching using the asterisk (*) and question mark (?) characters. The asterisk represents zero or more characters, while the question mark (?) wildcard represents zero or one characters.
Report Output

Generate a report by selecting **Configuration Profiler** from the Home ribbon of the console.

The report output is produced in sections and sub-sections covering the following details of the configuration:

- **Feature Options** — Provides details about features which are enabled, in passive mode, or include system processes.
- **Application Groups** — Provides details of the application groups which you have configured including the description and path of each application in the group and any command lines which are applicable.
- **Resource Planning** — Provides details of the resource planning settings for user groups and Application Groups including CPU, Memory and Disk settings.
- **Memory Optimizer** — Provides details of the Memory Optimizer settings including Analysis and Optimization schedules.
- **Thread Throttling** — Provides details of the Thread Throttling settings including CPU monitor, clamping action and exceptions.

The report displays in the Preview window where you can manage the following:

- **File settings**: Page Setup, Print, Export (PDF or image file), Send via email (PDF or image file)
  - **View**
  - **Background**: Color and Watermarks.
Resolve Configuration Violations

Violations can occur when conflicting values are present in a Performance Manager configuration. If you attempt to save a configuration with conflicts, the Configuration Violations dialog is displayed. This identifies the area of the configuration where the conflict arises and provides a description of the issue. All issues must be resolved before the configuration can be saved.

The following table provides details of configuration violations that can occur.

<table>
<thead>
<tr>
<th>Violation Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Group allocated more than once in the resource plan</td>
<td>In Resource Configuration &gt; Resource Planning, only one occurrence of an Application group can be allocated in the resource plan.</td>
</tr>
<tr>
<td>User Group allocated more than once in the resource plan</td>
<td>In Resource Configuration &gt; Resource Planning, only one occurrence of a user group can be allocated in the resource plan.</td>
</tr>
<tr>
<td>CPU Reservation value exceeds CPU Limit</td>
<td>In CPU, the Reservation must be less than or equal to the Limit.</td>
</tr>
<tr>
<td>The Physical Memory Minimum limit exceeds the Maximum</td>
<td>In Memory &gt; Physical Memory the Minimum limit must be less than or equal to the Maximum limit.</td>
</tr>
<tr>
<td>The User Memory Limits Warning Limit exceeds the Blocking Limit.</td>
<td>In the Memory &gt; User Memory Limits the Warning Limit must be less than the Blocking Limit.</td>
</tr>
<tr>
<td>[Clamp CPU by] exceeds [Apply clamping when CPU reaches].</td>
<td>In Thread Throttling, Clamp CPU by must be less than or equal to Apply clamping when CPU reaches.</td>
</tr>
<tr>
<td>[Do not clamp threads below] exceeds [Do not clamp processes below].</td>
<td>In Thread Throttling, Do not clamp threads below must be less than or equal to Do not clamp processes below.</td>
</tr>
<tr>
<td>Application Soft Memory Limits has been enabled but no action has been selected.</td>
<td>When applying Application Memory Limits to an Application Group and choosing a soft limit, an action of either close or terminate must be selected.</td>
</tr>
<tr>
<td>CPU Reservations &amp; Limits have been enabled but a value of zero has been entered.</td>
<td>When applying CPU Reservations and Limits a value greater than zero must be entered.</td>
</tr>
</tbody>
</table>
Feature Options

Performance Manager Feature Options provides system-wide settings that affect all users with the deployed configuration.

To access the Feature Options, click **Options** in the Resources Setup ribbon.

Feature Usage

For each Performance Manager feature, specify the following:

- **Enabled** - If selected, the feature is enabled.
- **Passive Mode** - If selected, the feature runs passively in the environment. Performance Manager makes no changes to the system, however it monitors and raises audit events where configured.
- **Include System Processes** - If selected, system processes are included for the feature.

Application Memory

Configure the content of the Close and Terminate warning messages. The following settings are available:

- **Close Message Details** - Configure the title and message displayed when applications are due to be closed for exceeding the specified application memory limit.
- **Terminate Message Details** - Configure the title and message displayed when applications are terminated for exceeding the specified application memory limit.

User Memory

Configure the content of the Warning and Blocked messages and the behavior of the messages. The following settings are available:

- **Warning Message Details** - Configure the title and message displayed when a user exceeds their memory limit.
- **Warning is Issued** - Configure when the warning message displays:
  - **Never** - A warning does not display when the user exceeds their memory limit.
  - **After every Transgression** - A warning displays on every occasion that the user exceeds their memory limit.
  - **After first Transgression** - A warning displays on the first occasion that the user exceeds their memory limit.
- **Repeat Warning** - Configure whether the warning message repeats and how frequently it repeats.
- **Blocked Message Details** - Configure the title and message displayed when applications are blocked due to a user exceeding the specified memory limit.
Excluded Applications

Add applications to exclude from Share Factor allocations and Thread Throttling policies.

Multi-process Applications

Add multi-process applications, such as web browsers, to efficiently manage CPU and memory resources for processes that spawn additional helper processes of the same name.

This feature allows multiple instances of the same process to be consolidated when considering the window’s state - foreground/background and maximized/minimized. For Microsoft Internet Explorer, this means each tab can be managed independently. For Google Chrome and other applications, Performance Manager calculates a summary window state so that the same foreground/background and minimized/maximized limits are applied to all matching processes based on their compounded windows state. This applies even if some matching processes have no windows or always have a fixed windows state, for example, if a helper process is always 'not visible' or in the background.

General

Apply general settings such as Share Factor Aggressiveness and Session Idle Timeout.

Specify the following options on the General tab:

- **Share Factor Aggressiveness** - Use the slider to set a value for Share Factor Aggressiveness. This value determines how quickly Performance Manager reacts to changes in the CPU load.
  
  When the slider is set to Max, Performance Manager reacts quickly to changes in load. This can cause Performance Manager to take unnecessary action against processes that have brief spikes in CPU load and cause control over high demand processes to be lifted too soon if they briefly lower their demand for CPU resources.

  When the slider is set to Min, Performance Manager monitors the effects of the changes over time, rather than taking immediate action. This can cause Performance Manager to take too long to control high loading CPU processes to free processes from control once they have definitively transitioned to a state of low CPU demand.

- **System Memory Settings** - Set whether overall system memory usage must reach a specified threshold before memory control is applied. Use the slider to set the threshold level.

- **Session Idle Timeout** - The Session Idle Timeout refers to the period when no keyboard and mouse activity takes place. This condition can be used in a rule to specify changes in resource allocations when the idle time reaches a set duration. The default setting is 10 minutes of no keyboard activity and mouse activity.

- **Number of CPUs** - Set the number of CPUs which can be used in CPU affinity settings in the CPU tab of a Resource Planning > Resource Allocations node.

- **Statistics Report Enabled** – Enable when a Central Statistics Server (CSS) is configured.
Application Groups

Application Groups are a collection of applications whose CPU, memory and disk resources can be controlled together. Applications can be added either manually or using Application Discovery.

In the configuration, Application Groups can be combined with specific users to allocate resources at a granular level. A typical Application Group could contain graphic-intensive applications which utilize a high proportion of system resources. A rule could be added to allow members of the Graphics Design team to run these applications with adequate resources.

Create Application Groups Manually

1. Select the **Resource Configuration** navigation button.
2. Select **Application Groups** in the navigation tree.
3. Click **Add New** from the Resources Setup ribbon.

The Add New Application Group dialog displays.

4. In the Name field, enter a name for the Application Group.
5. From the Type drop-down, select the type of applications to be added to the Application Group:
   - Desktop Applications.
   - Services.
   - 16-bit Applications.
6. Click **Add New**.
7. Enter an executable name, executable path or folder path in the Path field.

   Both the asterisk (*) and question mark (?) wildcard characters can be used in the file or folder path. The asterisk wildcard represents zero or more characters and the question mark wildcard represents zero or one character.

   For example, `C:\Folder*` matches all executables within `C:\Folder`.
Tip
To convert text to available Environment Variables, click the percentage sign and Convert To Use Environment Variables after entering the name or path.

8. If the Path field contains regular expressions, select **Use regular expressions**.

9. To match the command line, select **Enable command line matching** and enter the relevant command line.

10. In the Description field, enter a description for the application.

11. Click **Next**.

The Select Where to Go dialog displays.

12. Select one of the following options:

   - **Allocate Resources** - Adds the new Application Group to the Resource Planning node so that rules can be added.
   - **Finish** - Does not add the Application Group to the Resource Planning node. The Application Group can be added manually by selecting **Add Applications** from the Resources Setup ribbon.
Create Application Groups Using Application Discovery

Application Discovery can be used to populate Application Groups with installed applications, running processes or file types.

Application Discovery can be run on the local or a remote computer with the Performance Manager Agent installed.

1. Select the **Resource Configuration** navigation button.
2. Select **Application Groups** in the navigation tree.
3. Click **Add New** from the Resources Setup ribbon. The Add New Application Group dialog displays.

![Add New Application Group dialog](image)

4. In the Name field, enter a name for the Application Group.
5. From the Type drop-down, select the type of applications to be added to the Application Group:
   - Desktop Applications.
   - Services.
   - 16-bit Applications.
6. Click **Discover Applications**. A dialog to select the endpoint displays.

![Select a computer to discover applications from dialog](image)
7 Select the endpoint on which to perform the analysis:

- Select the local machine name to perform an analysis on the local endpoint.
- Select **A remote computer** to perform an analysis on a remote computer. The Connect to a Remote Computer dialog displays. Specify or navigate to the remote computer. Options are available to navigate to a computer on the network, one in the AppSense Management Center or to a favorite computer.

The Application Discovery dialog displays.

![Application Discovery dialog](image)

The dialog contains tabs to select installed applications, running processes and file types. It may take a few minutes to populate the data from the endpoint.

8 Once the data is populated, select the installed applications, running processes and file types to add to the Application Group. Filters can be applied by entering text into the Filter field.

9 Click **Next**.

The Add New Application Group dialog displays. The selected items from Application Discovery are added to the dialog.

10 Review the contents and, if necessary, amend the Path, Command Line and Description fields for each application.

11 Click **Next**.

The Select Where to Go dialog displays.
12 Select one of the following options:

- **Allocate Resources** - Adds the new Application Group to the Resource Planning node so that rules can be added.

- **Finish** - Does not add the Application Group to the Resource Planning node. The Application Group can be added manually by selecting Add Applications from the Resources Setup ribbon.
Resource Planning

About Resource Planning

CPU, memory and disk resources are allocated according to the Resource Plan within the configuration.

Resource Planning nodes are top-level Application Groups or User Groups that define how the overall system resources are allocated. Each Resource Planning node contains one or more sub-nodes to match specific Application Groups or User Groups. Each sub-node then contains one or more rules that match application attributes.

Evaluation Order

Performance Manager evaluates items in the following order to apply the Resource Plan:

1. Resource Planning nodes in descending order.
2. Resource Planning sub-nodes in descending order.

The arrows in the navigation pane and work area show the order of precedence.

In the above example, the Development node is evaluated first. If the user matches the User Group, then the sub-nodes under Development are evaluated.
Resource Planning Nodes

Resource Planning nodes are top-level User Groups or Application Groups. Resources are first allocated to the Resource Planning nodes. Finer control can be applied by adding sub-nodes for specific Application Groups or User Groups.

Add Resource Planning Nodes Based on User Groups

1. Select the Resource Configuration navigation button.
2. Select Resource Planning from the navigation tree.
   The Select User/Group dialog displays.
4. Choose a user or group using one of the following methods:
   - Enter the name of a user or group in the Name field.
   - Click the percent sign (%) and add an environment variable.
   - Click the ellipses (...) and browse to the user or group.

The User Group is added as a Resource Planning node to enable its resources to be managed.

Add Resource Planning Nodes Based on Application Groups

1. Select the Resource Configuration navigation button.
2. Select Resource Planning from the navigation tree.
3. On the Resources Setup ribbon, click Add Applications and select an Application Group for which to create a Resource Plan.

The Application Group is added as a Resource Planning node to enable its resources to be managed.

Re-order Resource Planning Nodes

1. Select the Resource Configuration navigation button.
2. Select a Resource Planning node from the navigation tree.
3. Select either Move Up or Move Down from the Resources Setup ribbon.

The Resource Planning node is moved up or down in the list.
CPU Share Factor

Share Factor allows the CPU resource to be split between Resource Planning nodes. It allocates User Groups or Application Groups a greater or lesser proportion of CPU time.

The pie chart in the work area provides a visual representation of the CPU allocation between the nodes. In the above example, the pie chart represents the relative CPU share between the Resource Planning nodes entitled Development, HR, Sales and <Other Users>.

To set CPU Share Factor:

1. Select the Resource Configuration navigation button.
2. Select a Resource Planning node in the navigation tree.
3. In the work area, select the CPU tab.
4. In the Share Factor section, adjust the Share Factor by either using the slider or entering a value into the box.

   As the Share Factor is adjusted, the pie chart updates to provide a visual representation of the resource allocation between the Resource Planning nodes.

The Share Factor of the Resource Planning node, relative to the other Resource Planning nodes, is set and the processor time is split accordingly on endpoints.
Set User Memory Limits

For Resource Planning nodes based on User Groups, memory limits can be set to restrict the amount of memory available to users within the group.

1. Select the **Resource Configuration** navigation button.

2. Select a Resource Planning node in the navigation tree.

   **Note**
   User Memory Limits can be applied to Resource Planning nodes based on User Groups only.

3. In the work area, select the **Memory** tab.

4. In the User Memory Limits section, select **Enabled**.

5. Specify the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning Limit</td>
<td>Set the memory level, in megabytes, at which a warning is displayed to users.</td>
</tr>
<tr>
<td>Blocking Limit</td>
<td>Set the memory level, in megabytes, at which new applications are blocked from launching.</td>
</tr>
<tr>
<td>Applications Never Blocked</td>
<td>Enter names or paths of applications that are never blocked. Click the percent sign (%) to insert an environment variable or click the ellipsis (...) to browse to the component.</td>
</tr>
</tbody>
</table>

As the limits are adjusted, the bar chart updates to provide a visual representation of the memory restrictions.

The memory limits are set for the Application Group. Applications that exceed the limit are controlled by warning or blocking.
Resource Planning Sub-nodes

Sub-nodes allow a finer level of control to be applied for specific Application Groups or User Groups. Rules within a Resource Planning sub-node allow resources to be allocated based upon attributes of the application window, such as whether it is maximized or minimized.

Add Resource Planning Sub-nodes Based on Application Groups

1. Select the Resource Configuration navigation button.
2. Select a Resource Planning node from the navigation tree.
3. On the Resources Setup ribbon, click Add Applications and select an Application Group for which to create a Resource Plan.

The Application Group is added as a Resource Planning node to enable its resources to be managed.

Add Resource Planning Sub-nodes Based on User Groups

1. Select the Resource Configuration navigation button.
2. Select a Resource Planning node from the navigation tree.

The Select User/Group dialog displays.

4. Choose a user or group using one of the following methods:
   - Enter the name of a user or group in the Name field.
   - Click the percent sign (%) and add an environment variable.
   - Click the ellipses (…) and browse to the user or group.

The User Group is added as a sub-node of the Resource Planning node to enable its resources to be managed.

Re-order Resource Planning Sub-nodes

1. Select the Resource Configuration navigation button.
2. Select a Resource Planning sub-node from the navigation tree.
3. Select either Move Up or Move Down from the Resources Setup ribbon.

The Resource Planning sub-node is moved up or down in the list.
Rules

Rules within a Resource Planning sub-node allow resources to be allocated based upon attributes of the application window, such as whether it is maximized or minimized.

In a typical setup, maximized windows in sessions that are connected, not idle and unlocked are given a greater proportion of the available resources.

Add Rules for Resource Planning Sub-nodes

1. Select the **Resource Configuration** navigation button.
2. Select a Resource Planning sub-node from the navigation tree.
3. From the Resources Setup ribbon, select **Add Rule**.

A new rule is created within the work area.

Add Conditions to Rules for Resource Planning Sub-nodes

1. Select the **Resource Configuration** navigation button.
2. Select a Resource Planning sub-node from the navigation tree.
3. In the work area, select a rule.
4. Select the **Conditions** tab.
5. Set one or more of the following conditions:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Position</td>
<td>Set whether the assigned application window is Minimized, Not Minimized, in the Foreground or in the Background.</td>
</tr>
<tr>
<td>Session Connected</td>
<td>Set whether the assigned application is running in a session that is Connected or Disconnected.</td>
</tr>
<tr>
<td>Session Idle</td>
<td>Set whether the assigned application is running in a session that is Idle or Not Idle.</td>
</tr>
<tr>
<td>Desktop</td>
<td>Set whether the assigned application is running in a session that is Locked or Unlocked.</td>
</tr>
</tbody>
</table>

The condition is added to the rule. The name of the rule is updated in the work area based upon the selected conditions.
Re-order Rules for Resource Planning Sub-nodes

1. Select the **Resource Configuration** navigation button.
2. Select a Resource Planning sub-node from the navigation tree.
3. From the Resources Setup ribbon, select either **Move Up** or **Move Down**.
The rule is moved up or down in the list.

CPU Share Factor for Resource Planning Sub-nodes

Share Factor allows the CPU resource to be split between Resource Planning sub-nodes. It provides Application Groups or User Groups a greater or smaller proportion of CPU time.

The pie chart in the work area provides a visual representation of the CPU allocation between all sub-nodes in the configuration.

To set CPU Share Factor:

1. Select the **Resource Configuration** navigation button.
2. Select a Resource Planning sub-node from the navigation tree.
3. In the work area, select a rule.
4. Select the **CPU** tab.
5. In the Share Factor section, adjust the Share Factor by either using the slider or entering a value into the box.
   
   As the Share Factor is adjusted, the pie chart updates to provide a visual representation of the resource allocation between the Resource Planning sub-nodes.

The Share Factor of the Resource Planning sub-node, relative to the other Resource Planning sub-nodes, is set and the processor time is split accordingly on endpoints.
CPU Reservations and Limits for Resource Planning Sub-nodes

CPU Reservations ensure that the Application Group or User Group has a guaranteed level of available CPU resource. CPU Limits restrict the amount of CPU resource available to the Application Group or User Group.

To set CPU Reservations and Limits:

1. Select the Resource Configuration navigation button.
2. Select a Resource Planning sub-node from the navigation tree.
3. In the work area, select a rule.
4. Select the CPU tab.
5. In the CPU Reservation & Limits section, set one or more of the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation</td>
<td>Ensure that a guaranteed level of CPU resource is available to the Application Group or User Group. At times of peak demand on the system, minimum reserved resources are obtained and the remaining resources are reallocated according to Share Factors.</td>
</tr>
</tbody>
</table>
| Limit | Prevent the Application Group or User Group exceeding specific CPU levels. Select the type of limit:  
  - **Soft Limit** - The restriction applies during high CPU demand only.
  - **Hard Limit** - The restriction applies even when spare capacity is available. |

As the Reservation and Limit fields are adjusted, the bar chart updates to provide a visual representation of the resource allocation relative to other sub-nodes.

The CPU Reservation or Limit is set. Where the Reservation is specified, the sub-node has a guaranteed level of CPU resource. Where the Limit is specified, the sub-node has a limited amount of CPU resource.
CPU Affinity for Resource Planning Sub-nodes

CPU Affinity restricts the Application Group or User Group to one or more specific CPUs.

To set CPU Affinity:

1. Select the Resource Configuration navigation button.
2. Select a Resource Planning sub-node from the navigation tree.
3. In the work area, select a rule.
4. Select the CPU tab.
5. In the CPU Affinity section, select Enabled and specify the CPU numbers.

Use commas to specify individual CPUs or dashes to specify ranges of CPUs. For example, 0,2 uses CPUs 0 and 2 and 0-2 uses CPUs 0, 1 and 2.

The CPU Affinity is set. The sub-node has the specified CPUs available only.
Physical Memory Limits for Resource Planning Sub-nodes

Physical Memory Limits allow a minimum or maximum amount of memory to be configured for the Application Group. Options are available to trim the process memory on application startup or when the application enters the rule.

To set Physical Memory Limits:
1. Select the Resource Configuration navigation button.
2. Select a Resource Planning sub-node from the navigation tree.
3. In the work area, select a rule.
4. Select the Memory tab.
5. In the Physical Memory Limits section, select Enabled.
6. Specify the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Minimum | Ensure that a guaranteed level of physical memory is available to the Application Group. At times of peak demand on the system, minimum reserved resources are obtained and the remaining resources are reallocated according to Share Factors. Select the type of limit:  
  - **Soft Limit** - The reservation applies during high memory demand only.  
  - **Hard Limit** - The reservation applies even when spare capacity is available. |

| Maximum | Prevent the Application Group exceeding specific physical memory levels. Select the type of limit:  
  - **Soft Limit** - The restriction applies during high memory demand only.  
  - **Hard Limit** - The restriction applies even when spare capacity is available. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trim process memory on application startup</td>
<td>Trim process memory when the process has been created. The memory is trimmed only once.</td>
</tr>
<tr>
<td>Trim process memory when application enters this rule</td>
<td>Trims a process memory whenever the state matches the associated state rule.</td>
</tr>
</tbody>
</table>

As the Minimum and Maximum fields are adjusted, the bar chart updates to provide a visual representation of the resource allocation.

The Physical Memory Limits are set. Where the Minimum is specified, the sub-node has a guaranteed level of physical memory. Where the Maximum is specified, the sub-node has a limited amount of physical memory. The process is trimmed according to the settings.
Application Memory Limits for Resource Planning Sub-nodes

Application Memory Limits allow the amount of virtual memory available to an application to be restricted. Applications can be either closed or terminated for exceeding their limit.

To set Application Memory Limits:

1. Select the Resource Configuration navigation button.
2. Select a Resource Planning sub-node from the navigation tree.
3. In the work area, select a rule.
4. Select the Memory tab.
5. In the Application Memory Limits section, select Enabled.
6. Specify the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Application Limit        | Set the memory level, in megabytes, at which the action is taken. Select the type of limit:  
  • **Soft Limit** - The limit applies during high memory demand only.  
  • **Hard Limit** - The limit applies even when spare capacity is available. |
| Close application after  | Users are prompted to close the application once the application has exceeded the limit for the specified number of minutes. |
| Terminate application after | The application is terminated once the application has exceeded the limit for the specified number of minutes. |

*Warning*
Terminating an application can result in data loss within the application.

As the Limit field is adjusted, the bar chart updates to provide a visual representation of the resource allocation.
The Application Memory Limits are set. The application is closed or terminated after exceeding the limit for the specified time.

Disk Priority for Resource Planning Sub-nodes

Disk Priority allows disk access to be prioritized for Application Groups or User Groups when demand is high.

In a typical setup, a background application could be given low priority disk access and a foreground application could be given high priority disk access.

To set Disk Priority:
1. Select the **Resource Configuration** navigation button.
2. Select a Resource Planning sub-node from the navigation tree.
3. In the work area, select a rule.
4. Select the **Memory** tab.
5. In the Physical Memory Limits section, select **Enabled**.
6. Specify the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Minimum | Ensure that a guaranteed level of physical memory is available to the Application Group. At times of peak demand on the system, minimum reserved resources are obtained and the remaining resources are reallocated according to Share Factors. Select the type of limit:  
  - **Soft Limit** - The reservation applies during high memory demand only.  
  - **Hard Limit** - The reservation applies even when spare capacity is available. |
| Maximum | Prevent the Application Group exceeding specific physical memory levels. Select the type of limit:  
  - **Soft Limit** - The restriction applies during high memory demand only.  
  - **Hard Limit** - The restriction applies even when spare capacity is available. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trim process memory on application startup</td>
<td>Trim process memory when the process has been created. The memory is trimmed only once.</td>
</tr>
<tr>
<td>Trim process memory when application enters this rule</td>
<td>Trims a process memory whenever the state matches the associated state rule.</td>
</tr>
</tbody>
</table>

As the Minimum and Maximum fields are adjusted, the bar chart updates to provide a visual representation of the resource allocation.

The Physical Memory Limits are set. Where the Minimum is specified, the sub-node has a guaranteed level of physical memory. Where the Maximum is specified, the sub-node has a limited amount of physical memory. The process is trimmed according to the settings.

**Windows Fair Share**

A reduction in performance management efficiency may occur where Windows Fair Share is enabled on machines with the Performance Manager agent installed. It is therefore recommended that Windows Fair Share is disabled.

To disable Windows Fair Share, set the following registry values:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\SessionManager\DFSS</td>
<td>Enable DFSS</td>
<td>0</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\TSFairShare\Disk</td>
<td>EnableFairShare</td>
<td>0</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\TSFairShare\NetFS</td>
<td>EnableFairShare</td>
<td>0</td>
</tr>
</tbody>
</table>
Global Resources

This section provides details about Global Resources settings for performing application memory optimization and thread throttling to manage CPU resources on the system.

Memory Optimizer

Memory Optimizer can analyze and optimize processes to prevent the same components from being loaded into memory multiple times. The stages are as follows:

- **Analysis** - Running processes are analyzed. Loaded components, such as DLL and OCX files, and their locations are recorded.
- **Optimization** - When processes are run, components found during the Analysis stage are copied to a central cache. Load addresses of components are modified to the central cache location.

Following Analysis and Optimization, future instances of the process use components from the central cache and are loaded into memory only once.

Analysis and optimization can be performed either on a schedule or manually.

Schedule Analysis

Memory optimization analysis can be scheduled to perform on an interval basis, every day or every week.

1. Select **Resource Configuration** in the navigation pane.
2. Select **Global Resources > Memory Optimizer** in the navigation tree.
3. Select the **Analysis Schedule** tab.
   
   The Analysis Schedule displays.
4. Specify when to perform the analysis, from the following options:
   
   - **Don’t Analyze** - Disable the scheduled analysis.
   - **Interval Basis** - Perform an analysis at a specified interval. The default setting is every 180 minutes.
   - **Every Day** - Perform an analysis at a particular time every day. The default setting is 10.00am.
   - **Specify Day** - Perform an analysis at a particular time on a particular day. The default setting is 10.00am on Sundays.

The analysis is performed as per the specified schedule.
Perform a Manual Analysis

Memory optimization analysis can be performed on demand on the local or a remote computer.

1. Select Resource Configuration in the navigation pane.
2. Select Global Resources > Memory Optimizer in the navigation tree.
3. Select the Analysis Schedule tab.
4. Select the Perform a Manual Analysis link.

The Manual Analysis dialog displays.

5. Select the endpoint on which to perform the analysis:
   - Select the local machine name to perform an analysis on the local endpoint.
   - Select A remote computer to perform an analysis on a remote computer. The Connect to a Remote Computer dialog displays. Specify or navigate to the remote computer. Options are available to navigate to a computer on the network, one in the AppSense Management Center or to a favorite computer.

6. Click Next.

   The Manual Analysis options display.

7. Select the operations to perform in the analysis from the following:
   - Clear Optimizer Cache - Clear existing optimized applications from the optimizer cache.
   - Analyze Applications - Analyze all applications on the specified computer. If Analyze All Applications is not selected, only running applications are analyzed. Memory Optimizer scans the computer to create a list of the running processes. A list of the results is displayed, including any errors.
   - Optimize Applications - Optimize all applications found during the analysis. Existing optimized applications in the cache are replaced where necessary.

8. Click Finish.

   The analysis is performed on the specified endpoint. The result displays during the operation.
Schedule Optimization

Memory optimization can be scheduled to perform following analysis, every day or every week.

1. Select Resource Configuration in the navigation pane.
2. Select Global Resources > Memory Optimizer in the navigation tree.
3. Select the Optimize Schedule tab.
   The Optimize Schedule displays.
4. Specify when to perform optimization from the following options:
   - **Don’t Optimize** - Disable the scheduled optimization.
   - **After Analysis** - Perform an optimization each time that analysis completes.
   - **Every Day** - Perform an optimization at a particular time every day. The default setting is 10.00am.
   - **Specify Day** - Perform an optimization at a particular time on a particular day. The default setting is 10.00am on Sundays.
5. Specify settings for the optimization from the following options:
   - **Include Signed Components** - Optimize files with digital signatures. A copy of the original file is made and the digital signature is removed. The original file remains unmodified with the signature intact. The copy without the digital signature is used during execution.
   - **Include Network Components** - Optimize files on network locations.
   - **Include Windows File Protection list Components** - Optimize components in the Windows File Protection list.
6. Specify the caching mode for the optimized components from the following options:
   - **Per-Drive Caching** - Store optimized local components on the drive from which they originate. Specify a drive for a local store of optimized network components.
   - **Single Drive Caching** - Store all optimized local and network components on a single drive.
Exclude Components from Analysis or Optimization

1. Select **Resource Configuration** in the navigation pane.
2. Select **Global Resources > Memory Optimizer** in the navigation tree.
3. Select the **Excluded Components** tab.
   The list of excluded components displays.
4. Click **Add** to exclude components from analysis or optimization.
   The Configure Exclusion dialog displays.
5. In the Exclude Component field, enter the name or path of the component to exclude.
   Click the percent sign (%) to insert an environment variable or click the ellipsis (...) to browse
   to the component.
   **Tip**
   To convert text to available Environment Variables, click the percentage sign and **Convert To Use Environment Variables** after entering the name or path.
6. Select **Use regular expressions** to enable the component name or path to be evaluated as a
   regular expression. For example, C:\Folder[0-9] will exclude components in folders named
   C:\Folder0 to C:\Folder9.
7. In the Exclude When drop-down, select whether to exclude the component from analysis or
   optimization.
8. If required, enter comments in the Comments field. These comments are visible in the console.
9. Click **OK**.
   The component is excluded from either analysis or optimization.
Exclude Applications from Analysis or Optimization

1. Select Resource Configuration in the navigation pane.
2. Select Global Resources > Memory Optimizer in the navigation tree.
3. Select the Excluded Applications tab.
   The list of excluded applications displays.
4. Click Add to exclude applications from analysis or optimization.
   The Configure Exclusion dialog displays.
5. In the Exclude Application field, enter the name or path of the application to exclude.
   Click the percent sign (%) to insert an environment variable or click the ellipsis (...) to browse to the application.
   **Tip**
   To convert text to available Environment Variables, click the percentage sign and Convert To Use Environment Variables after entering the name or path.
6. Select Use regular expressions to enable the application name or path to be evaluated as a regular expression. For example, C:\Folder[0-9] excludes components in folders named C:\Folder0 to C:\Folder9.
7. In the Exclude When drop-down, select whether to exclude the component from analysis or optimization.
8. If required, enter comments in the Comments field. These comments are visible in the console.
9. Click OK.
   The application is excluded from either analysis or optimization.
Thread Throttling™

Thread Throttling sets a system-wide CPU thread throttling policy that triggers when the system is heavily loaded. The throttling provides unutilized processor time to allow new users to log on or new applications to execute.

Performance Manager samples system performance data at one second intervals. Once the system is detected to be in a heavily loaded state for the specified interval, threads are clamped to achieve the specified percentage reduction in server load. The clamp is unapplied after the specified duration. Where necessary, clamping is reapplied repeatedly until the processor remains stable.

Example

The example below explains typical Thread Throttling behavior. As the options are set in the console, the chart updates to provide a visual representation of the behavior.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>The CPU utilization reaches the threshold of 95%, as specified in the Monitor section.</td>
</tr>
<tr>
<td>B</td>
<td>The CPU remains at or above the threshold of 95% for 20 seconds, as specified in the Monitor section.</td>
</tr>
</tbody>
</table>
Configure Thread Throttling

To configure Thread Throttling:

1. Select **Resource Configuration** in the navigation pane.
2. Select **Global Resources > Thread Throttling** in the navigation tree.
3. Select **Enabled**.
4. Specify the following settings:

<table>
<thead>
<tr>
<th>Section</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor</td>
<td>Set the CPU utilization percentage and the internal (in seconds) for which the CPU must remain at the utilization level before clamping is applied. Additionally, set whether the clamping occurs when any one processor reaches the threshold on multi-processor systems. It is recommended that the interval does not exceed 60 seconds.</td>
</tr>
<tr>
<td>Action</td>
<td>Set the percentage by which to clamp the CPU and for how long the clamp is applied (in seconds). It is recommended that the clamp duration does not exceed 60 seconds.</td>
</tr>
<tr>
<td>Exception</td>
<td>Set the minimum CPU utilization for processes and threads to be clamped. Processes and threads below the specified level are not clamped.</td>
</tr>
</tbody>
</table>

As the options are set, the chart in the work area updates to provide a visual representation of the Thread Throttling behavior.

Thread Throttling is enabled for all users on the system. When the system reaches the specified CPU utilization threshold for the specified interval, threads are clamped by Performance Manager.
Include System Processes in Thread Throttling

By default, system processes are not included in Thread Throttling. This ensures system processes continue running for critical system tasks.

1. Click **Options** on the Resources Setup ribbon.
   
   The Feature Options dialog displays.

2. Select the **Feature Usage** tab.

3. On the Thread Throttling row, select **Include System Processes**.

4. Click **OK**.

   System processes are included in the Thread Throttling behavior.
Optimizer Monitor

This section provides details about the Optimizer Monitor which provide summaries of the memory savings for optimized applications, and allows you to select local and remote computers for performing manual analyses and optimization.

**Note**
You must be connected to a live configuration in order to view optimization reports and perform Manual Analyses. You can connect to a live configuration on the local computer or a remote computer either using the options in the Application menu or by running Manual Analysis.

Memory Optimizer Summary

Memory Optimizer Summary provides summary details of the optimization settings, memory savings and top ten optimizations.

Optimizer Configuration

Provides a list of key optimization settings in Memory Optimizer and Feature Options, including:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimizer Enabled</td>
<td>Optimizer can be disabled in the Feature Options &gt; Feature Usage which you access by selecting Options on the Resources Setup ribbon.</td>
</tr>
<tr>
<td>Passive mode</td>
<td>Optimizer can be set to operate in Passive Mode only in the Feature Options &gt; Feature Usage dialog which you access by selecting Options on the Resources Setup ribbon. In this mode, Performance Manager monitors performance control actions affecting memory utilization before you commit to the policies for taking corrective action.</td>
</tr>
<tr>
<td>Include system processes</td>
<td>Indicates whether system processes are optimized.</td>
</tr>
<tr>
<td>Analysis...</td>
<td>Details of the analysis schedule.</td>
</tr>
<tr>
<td>Optimization...</td>
<td>Details of the optimization schedule.</td>
</tr>
<tr>
<td>Optimize signed components</td>
<td>Indicates whether components with digital signatures are optimized.</td>
</tr>
<tr>
<td>Optimize network components</td>
<td>Indicates whether network components are optimized.</td>
</tr>
</tbody>
</table>
Provides a brief list of actual and potential memory statistics.

Best Application Memory Savings

Provides a grid view of the top 10 optimized applications.

The report includes:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>The name of the optimized application and the name of the executable file.</td>
</tr>
<tr>
<td>Memory Saving (KB)</td>
<td>Details of the memory savings in kilobytes.</td>
</tr>
<tr>
<td>Instances</td>
<td>The number of running instances of the optimized application.</td>
</tr>
<tr>
<td>Last Analyzed</td>
<td>Date and time of the last analysis.</td>
</tr>
<tr>
<td>Last Optimized</td>
<td>Date and time of the last optimization.</td>
</tr>
</tbody>
</table>

Optimized Applications

Optimized Applications shows actual and potential memory savings and provides a report on the status of all applications which are eligible for optimization according to the Memory Optimizer settings.

The report includes information about each application such as resolved path, Process Identifier (PID), last analyzed and optimized date and time, actual and potential memory savings.

Expandable lists showing the components of the applications include further details about each component such as the directory path and name, excluded status, actual and potential memory savings and the state.

Component State

<table>
<thead>
<tr>
<th>State</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Not optimized for one of the following reasons:</td>
</tr>
<tr>
<td></td>
<td>• Excluded</td>
</tr>
<tr>
<td></td>
<td>• The optimizer could not analyze the component</td>
</tr>
<tr>
<td></td>
<td>• The component has not yet been optimized</td>
</tr>
<tr>
<td>Optimized Loaded</td>
<td>• Optimized</td>
</tr>
<tr>
<td></td>
<td>• Loaded into memory</td>
</tr>
</tbody>
</table>
### State Descriptions

<table>
<thead>
<tr>
<th>State</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimized Not Loaded</td>
<td>• Optimized</td>
</tr>
<tr>
<td></td>
<td>• Original version is loaded into the process</td>
</tr>
</tbody>
</table>

### Actual Memory Savings

The Actual Memory Savings reports shows the amount of memory that has been saved provides information on the status of all applications which are eligible for optimization according to the Memory Optimizer settings.

The report includes information about each application such as resolved path, Process Identifier (PID), last analyzed and optimized date and time, actual and potential memory savings.

Expandable lists showing the components of the applications include further details about each component such as the directory path and name, excluded status, actual memory savings and the state.

### Component State

<table>
<thead>
<tr>
<th>State</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Not optimized for one of the following reasons:</td>
</tr>
<tr>
<td></td>
<td>• Excluded</td>
</tr>
<tr>
<td></td>
<td>• The optimizer could not analyze the component</td>
</tr>
<tr>
<td></td>
<td>• The component has not yet been optimized</td>
</tr>
<tr>
<td>Optimized Loaded</td>
<td>• Optimized</td>
</tr>
<tr>
<td></td>
<td>• Loaded into memory</td>
</tr>
<tr>
<td>Optimized Not Loaded</td>
<td>• Optimized</td>
</tr>
<tr>
<td></td>
<td>• Original version is loaded into the process</td>
</tr>
</tbody>
</table>
Applications Without Memory Savings

Applications Without Memory Savings provides a report on the status of all applications for which there are no memory savings and indicates whether an application is excluded from optimization according to the Memory Optimizer settings.

The report includes information about each application such as resolved path and Process Identifier (PID).

Expandable lists showing the components of the applications include further details about each component such as the directory path and name, excluded status and the state.

Component State

<table>
<thead>
<tr>
<th>State</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Not optimized for one of the following reasons:</td>
</tr>
<tr>
<td></td>
<td>• Excluded</td>
</tr>
<tr>
<td></td>
<td>• The optimizer could not analyze the component</td>
</tr>
<tr>
<td></td>
<td>• The component has not yet been optimized</td>
</tr>
<tr>
<td>Optimized Loaded</td>
<td>• Optimized</td>
</tr>
<tr>
<td></td>
<td>• Loaded into memory</td>
</tr>
<tr>
<td>Optimized Not Loaded</td>
<td>• Optimized</td>
</tr>
<tr>
<td></td>
<td>• Original version is loaded into the process</td>
</tr>
</tbody>
</table>
Monitoring Ribbon

The Monitoring tab displays when you select the Optimizer Monitor view in the navigation pane. The tab includes options for managing the target computers and groups and for performing analyses.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Favorite Computers</td>
<td>Allows you to maintain a list of computers which is available when connecting to other computers. You can arrange computers in groups and populate them with computers specified by URL or DNS.</td>
</tr>
<tr>
<td>Deployed Groups</td>
<td>Allows you to view the list of deployment groups and managed computers on the Management Center.</td>
</tr>
</tbody>
</table>
| Analysis | Perform Manual Analysis and optimization on the local and remote computers. Allows you to select individual options:  
  - Clear the optimization cache  
  - Perform analysis  
  - Perform optimization |
| Reporting Options | Allows you to enable or disable showing fully resolved paths for applications in optimization reports. |
Auditing

Use Auditing to define rules for the capture of auditing information, you can setup rules about where event data is stored for logging to a local file and the application event log, and you can setup filters to specify the events you want to capture in the log.

Local Auditing allows you to specify whether to log events in the Windows Application Event Log or to a custom AppSense Event Log. Events can be written to a local file in CSV or XML format.

By default, the log file is located at %SYSTEMDRIVE%\AppSenseLogs\Auditing\PerformanceManagerEvents_%COMPUTERNAME%.csv (or .xml)

An alternative location can be configured for the log file. In this mode, auditing also includes an event filter to log only specific events.

When managed by the AppSense Management Center, events are forwarded via the Deployment Agent (CCA). Under these conditions, event data storage and filtering is configured through the AppSense Management Console.

Make events anonymous

Specify whether events are to be anonymous. If Yes, the computer name and user name is omitted from all events. Anonymous logging also searches the file path for any instances where a directory matches the username and replaces the directory name with the string USERNAME or COMPUTERNAME.

Send events to local file log

Select whether to send events to the local file log. If Yes, the events are sent to the local log file as specified in the Text box. The default is:

%SYSTEMDRIVE%\AppSenseLogs\Auditing\PerformanceManagerEvents_%COMPUTERNAME%.csv (or .xml)

Local file log format

Specify whether the event log is to be saved in XML format or CSV format.
Local Events

The Event filter table is a comprehensive list of all events and is used to select the events you wish to audit. You can sort the table numerically by ID number, or alphabetically by Event Name or Event Description. Selected events are highlighted in bold. Click **Toggle selected** to change the states between selected and cleared.

**Note**
Events are reported to the local Windows Event Log or the local AppSense Event Log, according to the Deployment Group Events settings, and also to the Management Server by the Deployment Agent (CCA), unless otherwise indicated.

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Event Name</th>
<th>Event Description</th>
<th>Event Log Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>9100</td>
<td>User Memory Usage Warning</td>
<td>Amount of memory consumed by a user has exceeded a warning level set in a User Memory Limit.</td>
<td>Information</td>
</tr>
<tr>
<td>9101</td>
<td>User memory usage warning lapsed</td>
<td>Amount of memory consumed by a user has fallen back to a safe level as defined in a User Memory Limit.</td>
<td>Information</td>
</tr>
<tr>
<td>9102</td>
<td>User memory usage blocked</td>
<td>Amount of memory available to this user as defined in a User Memory rule has been exceeded. No more memory allocation will be allowed.</td>
<td>Warning</td>
</tr>
<tr>
<td>9103</td>
<td>User memory usage blocking lapsed</td>
<td>Amount of memory consumed by a user has fallen back to a safe (non-blocked) level as defined in a User Memory Limit.</td>
<td>Information</td>
</tr>
<tr>
<td>9104</td>
<td>Thread Throttling Clamping On</td>
<td>Total CPU Usage has exceeded a threshold and will be clamped.</td>
<td>Information</td>
</tr>
<tr>
<td>9105</td>
<td>Thread Throttling Clamping Off</td>
<td>Total CPU Usage has fallen under a threshold and clamping will stop.</td>
<td>Information</td>
</tr>
<tr>
<td>9106</td>
<td>Application CPU Usage clamping On</td>
<td>An Application has exceeded its CPU Usage limit.</td>
<td>Information</td>
</tr>
<tr>
<td>9107</td>
<td>Per Application Memory Usage Exceeded</td>
<td>Memory usage for a particular application has exceeded a threshold.</td>
<td>Information</td>
</tr>
<tr>
<td>9108</td>
<td>Per Application Memory Usage Reduced</td>
<td>Memory usage for a particular application has dropped below a threshold.</td>
<td>Information</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Name</td>
<td>Event Description</td>
<td>Event Log Type</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>9109</td>
<td>Per Application Memory Usage Terminated</td>
<td>An application has been terminated because it used too much memory.</td>
<td>Warning</td>
</tr>
<tr>
<td>9110</td>
<td>Application CPU Usage Clamping Off</td>
<td>An application has now fallen below its CPU Usage limit and will no longer be clamped.</td>
<td>Information</td>
</tr>
<tr>
<td>9115</td>
<td>Working set trimmed</td>
<td>Working set for an application has been trimmed.</td>
<td>Information</td>
</tr>
<tr>
<td>9116</td>
<td>CPU Affinity changed</td>
<td>CPU Affinity of an application has changed.</td>
<td>Information</td>
</tr>
<tr>
<td>9119</td>
<td>Per Application Hard Memory Limit Reached</td>
<td>Memory usage for a particular application has reached its maximum limit.</td>
<td>Warning</td>
</tr>
<tr>
<td>9120</td>
<td>Thread Throttling - Clamped Processes</td>
<td>Total CPU Usage has exceeded a threshold and applications will be clamped.</td>
<td>Information</td>
</tr>
<tr>
<td>9121</td>
<td>Application CPU Soft Limit - Started</td>
<td>Because of the overall CPU Usage a CPU soft limit will be applied to an application.</td>
<td>Information</td>
</tr>
<tr>
<td>9122</td>
<td>Application CPU Soft Limit - Stopped</td>
<td>An application will be no longer controlled by an CPU soft limit.</td>
<td>Information</td>
</tr>
<tr>
<td>9123</td>
<td>Application CPU Reservation Applied</td>
<td>A CPU Usage reservation was applied to an application.</td>
<td>Information</td>
</tr>
<tr>
<td>9124</td>
<td>Disk - Process I/O Queued</td>
<td>One or more processes were subject to I/O queuing.</td>
<td>Information</td>
</tr>
<tr>
<td>9150</td>
<td>Windows Performance Counter Error</td>
<td>The Windows performance counters on this machine are missing or broken.</td>
<td>Error</td>
</tr>
<tr>
<td>9170</td>
<td>Settings not found in package</td>
<td>Some configuration settings were not found in the configuration package.</td>
<td>Error</td>
</tr>
<tr>
<td>9171</td>
<td>Settings not valid in package</td>
<td>Some configuration settings in the configuration package were not valid.</td>
<td>Error</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Name</td>
<td>Event Description</td>
<td>Event Log Type</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>9172</td>
<td>Settings loaded from package</td>
<td>The configuration settings were successfully loaded from the configuration package.</td>
<td>Information</td>
</tr>
<tr>
<td>9173</td>
<td>Settings applied live to the Agent</td>
<td>The configuration settings were applied live to a running Performance Manager Agent.</td>
<td>Information</td>
</tr>
<tr>
<td>9174</td>
<td>Package has been loaded and all settings applied</td>
<td>All settings in the package have been applied to the Agent.</td>
<td>Information</td>
</tr>
<tr>
<td>9175</td>
<td>The package is invalid</td>
<td>The configuration package is invalid.</td>
<td>Error</td>
</tr>
<tr>
<td>9176</td>
<td>Package not found</td>
<td>The configuration package does not exist.</td>
<td>Warning</td>
</tr>
<tr>
<td>9197</td>
<td>Valid License Found</td>
<td>Performance Manager is licensed.</td>
<td>Information</td>
</tr>
<tr>
<td>9198</td>
<td>Invalid License Found</td>
<td>Performance Manager has detected a product license which is not compatible with the current used Performance Manager version. Upgrade your Performance Manager license.</td>
<td>Error</td>
</tr>
<tr>
<td>9199</td>
<td>Valid License Not Found</td>
<td>Performance Manager is not licensed.</td>
<td>Error</td>
</tr>
<tr>
<td>9200</td>
<td>Application Analyzed</td>
<td>Memory Optimizer has analyzed a known application.</td>
<td>Information</td>
</tr>
<tr>
<td>9201</td>
<td>Component Analyzed</td>
<td>Memory Optimizer has analyzed a known component.</td>
<td>Information</td>
</tr>
<tr>
<td>9202</td>
<td>Component Optimized</td>
<td>Memory Optimizer has optimized a known component.</td>
<td>Information</td>
</tr>
<tr>
<td>9203</td>
<td>Component failed to Optimize</td>
<td>AppSense Performance Manager has failed to optimize a component</td>
<td>Warning</td>
</tr>
<tr>
<td>9204</td>
<td>Application Identified At Runtime</td>
<td>Memory Optimizer has analyzed a running process and added a new application to the optimization database.</td>
<td>Information</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Name</td>
<td>Event Description</td>
<td>Event Log Type</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>9205</td>
<td>Component Identified At Runtime</td>
<td>Memory Optimizer has analyzed a loaded component in a process and added it to the optimization database.</td>
<td>Information</td>
</tr>
<tr>
<td>9206</td>
<td>Database Analyzed</td>
<td>Memory Optimizer has analyzed all known applications within the optimization database.</td>
<td>Information</td>
</tr>
<tr>
<td>9207</td>
<td>Database Optimized</td>
<td>Memory Optimizer has optimized all known applications within the optimization database.</td>
<td>Information</td>
</tr>
<tr>
<td>9208</td>
<td>Application Optimized</td>
<td>Memory optimizer has optimized a known application.</td>
<td>Information</td>
</tr>
<tr>
<td>9209</td>
<td>Database Cleaned</td>
<td>Memory Optimizer has cleaned the optimization database.</td>
<td>Information</td>
</tr>
<tr>
<td>9210</td>
<td>Application Cleaned</td>
<td>Memory Optimizer has cleaned a known application.</td>
<td>Information</td>
</tr>
<tr>
<td>9211</td>
<td>Component Cleaned</td>
<td>Memory Optimizer has cleaned a known component.</td>
<td>Information</td>
</tr>
<tr>
<td>9212</td>
<td>Out Of Memory</td>
<td>Memory Optimizer has run out of memory and cannot rebase any more DLLs.</td>
<td>Error</td>
</tr>
<tr>
<td>9235</td>
<td>NP-VDI Config path Update</td>
<td>Detected the Deployment Agent has updated the endpoint native configuration path.</td>
<td>Error</td>
</tr>
<tr>
<td>9236</td>
<td>System Memory Exceeded Threshold Warning</td>
<td>The system memory has exceeded the minimum threshold. New processes will be eligible for memory limitations.</td>
<td>Warning</td>
</tr>
<tr>
<td>9237</td>
<td>System Memory Exceeded Threshold Lapse</td>
<td>The system memory has fallen back below the minimum threshold. New processes will not be monitored for memory limitations.</td>
<td>Warning</td>
</tr>
</tbody>
</table>
## System Events

The following are non-configurable system events:

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Event Name</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8000</td>
<td>Service Started</td>
<td>[Product Name] Agent: Service Started</td>
</tr>
<tr>
<td>8001</td>
<td>Service Stopped</td>
<td>[Product Name] Agent: Service Stopped</td>
</tr>
<tr>
<td>8095</td>
<td>No Configuration found</td>
<td>[Product Name] cannot find a valid configuration</td>
</tr>
<tr>
<td>8096</td>
<td>Configuration Upgraded</td>
<td>A configuration for a previous version of [Product Name] has been detected and upgraded.</td>
</tr>
<tr>
<td>8099</td>
<td>Invalid License</td>
<td>[Product Name] software is not licensed.</td>
</tr>
</tbody>
</table>
Streamed Applications

To set up Citrix XenApp streaming applications to work with Performance Manager you need to specify certain exclusions, as follows:

1. Navigate to Citrix Streaming Profiler for Windows.
2. Open the Application Profile.
3. Highlight the relevant Target and select the Edit menu.
5. Select Rules. The Rules work area displays on the right hand side.
6. Click Add in the Rules work area. The New Rule Select Action and Objects dialog displays.
7. In the Action section leave the default setting as Ignore.
8. In the Object section select Named Objects and click Next. The New Rule Select Objects dialog displays.
10. Add \??\pipe\AppSense* and click OK. This displays in Named Objects on the New Rule Select Objects dialog.
11. Click Next to display the New Rule Name Rule dialog.
12. Enter a name for the rule or accept the default and click Finish.
13. Click OK. The Target Properties screen re-displays and the Ignore all named objects rule is now listed in the work area on the right hand side.
14. Save the profile.
15. Repeat for each application profile as required.
Environment Variables

You can convert to environment variables certain types of data which are manually entered in different areas of the Performance Manager console. For example, directory paths to applications. Environment variables are available by selecting the percent sign (%) where it appears in particular dialogs. For example, the Add New Application Group dialog.

The following table shows the types of environment variables and where they can be used in the Performance Manager console.

<table>
<thead>
<tr>
<th>Environment Variables</th>
<th>Add Users/Groups</th>
<th>Add Application</th>
<th>Memory Optimizer: Exclusion</th>
<th>User Memory Limits: Applications Never Blocked</th>
</tr>
</thead>
<tbody>
<tr>
<td>%ProgramFiles%</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>%SystemRoot%</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>%SystemDrive%</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>%CommonProgramFiles%</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>%AllUsersProfile%</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>%ComputerName%</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>%WinDir%</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Glossary

A

**AAMP:** See AppSense Application Manager Package

**Adler-32:** A checksum algorithm that can be applied to application files. See also: SHA-1 and SHA-256.

**ADM:** See Microsoft Administrative Template

**AEMP:** See AppSense Environment Manager Package

**agent:** An executable component that implements the product configuration settings. The DesktopNow agent is software that runs as a Windows service to carry out tasks on a computer, as specified by the configuration deployed to that computer.

**Allowed Items:** Files, folders, drives or digitally signed files or groups of files in a DesktopNow configuration Privilege Discovery that are allowed to run when file execution requests are matched with the rule security settings and would otherwise be denied by other configuration settings. See also: Denied Items

**AM Web Service:** The Application Manager web service that can be installed on any machine and used to collect data from the enabled Privilege Discovery feature.

**AMDX:** See Microsoft Administrative Template XML-Based.

**ANAC:** See Application Network Access Control.

**APMP:** See AppSense Performance Manager Package.

**App-V:** See Microsoft Application Virtualization.

**Application Group:** A custom list of applications to which you assign rules for controlling CPU, memory or disk resources. Application Groups are associated with particular types of applications, desktop applications, services, or 16-bit applications.

**Application Limit:** An Application Manager setting, applied to an Allowed Item, that specifies the number of instances of an application that a user can run.

**Application Network Access Control (ANAC):** An approach to computer network security that controls outbound network connections by IP Address, host name, URL, UNC, or port, based on the outcome of rules processing. In Application Manager ANAC is implemented using Network Connection Items and Reverse DNS Lookup.

**Application Termination:** An Application Manager feature that allows you to set triggers, behavior, and warning messages for terminating applications on managed computers.

**AppSense Application Manager Package (AAMP):** The configuration file that stores settings created in Application Manager Configuration and is then deployed to endpoints. The agent uses the configuration settings to determine whether or not an execute request is to be denied.

**AppSense Environment Manager Package (AEMP):** The configuration file that stores settings created in Environment Manager Policy Configuration and is then deployed to endpoints to manage the policy configuration on those endpoints as defined in the settings.
**AppSense Performance Manager Package (APMP):** The configuration file that stores the policies created in Performance Manager for managing performance and resources on managed endpoints, and is then deployed to endpoints to manage performance as defined.

**Audit Only:** Security Level assigned to users, groups or devices in an Application Manager Privilege Discovery that audits events according to the auditing configuration without applying the rule. Used for passive monitoring in evaluations to assess application usage on the host environment.

**B**

**base configuration:** In endpoint configuration merging, the first configuration in the merge onto which the other configurations are added.

**C**

**cascadeBHO.dll:** An Application Manager Browser Helper Object (BHO) loaded by Internet Explorer that is used as part of the URL Redirection and Elevated Web Sites features.

**Citrix XenApp:** A thin client product that allows users to connect to their corporate applications. XenApp can either host applications on central servers and allow users to interact with them remotely or stream and deliver them to user devices for local execution.

**client computer:** The device on which user login sessions are hosted.

**Client Debug Setup Utility:** An Environment Manager standalone utility, installed from the EM Tools Installer, which enables and disables the generation of diagnostic logs used by AppSense Support when diagnosing reported issues.

**COM:** A binary-interface standard for software components introduced by Microsoft. It is used to enable inter-process communication and dynamic object creation in programming languages.

**configuration:** A collection of settings created in the product console, in which a navigation tree of component settings graphically represents the configuration while it is created and modified by the administrator.

**configuration file:** A DesktopNow configuration saved as a native configuration file (*.aamp, *.aemp, or *.apmp) or an XML file, or exported from the product console in Windows Installer MSI file format. The file can be installed on any computer and the configuration rules applied when a DesktopNow Agent is present and running as a service on the computer. See also: AppSense Application Manager Package (AAMP), AppSense Environment Manager Package (AEMP), and AppSense Performance Manager Package (APMP)

**Configuration Profiler:** In the product console, a feature that generates reports detailing the current settings in the configuration. Filtering options allow you to query settings affecting specific users or groups, devices, and files or folders.

**Constant Special Item ID List (CSIDL):** A set of values that provide a unique, system-independent way to identify special folders used frequently by applications, but which may not have the same name or location on any given system.

**CSIDL:** See Constant Special Item ID List.
DAC: See Discretionary Access Control.

Database Management System (DBMS): Computer management software that manages databases installed on a system or network.

DBMS: See Database Management System.

Denied Items: Items that are not allowed to run when file execution requests are matched with the rule security settings and would otherwise be allowed by other configuration settings. See also: Allowed Items

Deployment Agent (CCA): A software service installed on computers to provide communication between the product agent running on a managed computer and the AppSense Management Center. The Deployment Agent (CCA) sends event data generated by the product agents to the Management Server and also polls the Management Server to manage the download and installation of software configuration, agent and package updates.

Desktop Settings: User Personalization session specific settings which include; Accessibility, Appearance, Keyboard, Mouse, Language, Screensaver, Cursors and Certificates.

DFS: See Distributed File System.

digital signature: A means to accurately validate the authenticity of a file according to the actual contents of the file itself by using a mathematical technique (a cryptographic hashing algorithm). If the file is altered in any way then the SHA-1 hash is also altered. Application Manager has a Signature Wizard that allows you to apply digital signatures either to an individual file or a group. The signature can be used as a security measure when adding files as Allowed Items, Denied Items and Trusted Vendors. Application Manager uses the industry standard SHA-1, SHA-256 and Adler-32 hashes.

Discretionary Access Control (DAC): A type of access control defined by the Trusted Computer System Evaluation Criteria as a means of restricting access to objects based on the identity of subjects and/or groups to which they belong.

Distributed File System (DFS): Any file system that allows access to files from multiple hosts sharing via a computer network.

DLL: See Dynamic Link Library.

DNS: See Domain Name System.

Domain Name System (DNS): A system that translates a computer’s fully qualified domain name into an IP address.

Dynamic Link Library (DLL): A collection of software functionality that a running executable can call upon as needed, for example to communicate with a specific device such as a printer or to perform particular tasks.
EM: See Environment Manager.

EM Tools: A collection of standalone tools installed from the EM Tools Installer, which assist administrators when creating configurations and working with the Personalization Database.

EmMon: See Environment Manager Monitor.

EMP: See Environment Manager Personalization.

EMP File Utility: A standalone utility, installed from the EM Tools Installer, which imports and exports files to and from the Environment Manager Personalization database.

EMP Migrate Utility: A standalone utility, installed from the EM Tools Installer, which allows user data to be copied from a source database to a target database.

EMP Registry Utility: A standalone utility, installed from the EM Tools Installer, which relocates registry keys when multiple versions are stored in user profiles in the Personalization database.

Endpoint Analysis (EPA): In Application Manager, the functionality to monitor managed endpoints to provide a list of applications that are present and that have run on a particular computer.


Environment Manager (EM): An AppSense user virtualization solution that ensures users always receive a consistent, predictable, and personalized working experience.

Environment Manager Logging Setup Tool: In Environment Manager, a standalone utility, installed from the EM Tools Installer, which enables and disables the generation of diagnostic logs used by AppSense Support when diagnosing reported issues.

Environment Manager Monitor (EmMon): In Environment Manager, a standalone utility, installed from the EM Tools Installer, that provides a user interface to view and analyze log files from the Environment Manager Agent. This tool replaces Environment Manager LogViewer.

Environment Manager Personalization (EMP): An Environment Manager feature that captures a user’s application and desktop changes to a central database and reapplies them for the user upon logon or application start, regardless of operating system or delivery mechanism.

Environment Manager Support console: An abridged version of the Environment Manager console, available to users with the Support Console role, that offers read-only access to Environment Manager configurations and full access to Personalization Analysis functionality.

EPA: See Endpoint Analysis.
F

FBR Explorer: A standalone utility, installed from the EM Tools Installer, which open any File Based Registry (FBR) enabling the keys and values stored for an application to be viewed.

filter driver: An optional driver that adds value to or modifies the behavior of a device. A filter driver can service one or more devices.

fixed node: In the product console navigation tree, a node that cannot be deleted or edited.

Folder Redirection: A Microsoft Windows component that can be controlled by group policy. Environment Manager simplifies its configuration.

G

Globally Unique Identifier (GUID): A unique reference number used as an identifier in computer software.

Group Management: In Application Manager, a library for compiling reusable groups of files, folders, drives, signatures, and network connections that can be associated with rules in the configuration. For example, Groups can be used to manage licenses for a suite of software or common sets of applications for assigning to certain user groups.

Group Policy: A set of configuration rules that can be defined to manage the working environment of users and computers.

GUID: See Globally Unique Identifier.

L

Local Security Authority (LSA): A required Windows component that deals with login authentication and security policies.

lockdown: An Environment Manager mechanism to restrict or disable access to specific application and operating system functionality, keyboard shortcuts, Microsoft Office application menus, and toolbars.

LSA: See Local Security Authority.
**M**

**managed application:** Applications that have their settings and any changes made to those settings captured by Environment Manager Personalization.

**Management Server:** The machine on which product configurations and configuration versions are stored, from which configurations can be deployed to machines designated by the administrator.

**Masquerading Applications:** Applications that are allowed to run against the personalization caches of another application in order to use its Personalization data. This is especially useful when using multiple applications on multiple endpoints in situations where using a Personalization Group is not feasible.

**Microsoft Administrative Template (ADM):** The file type of the administrative template files that are used by Environment Manager Group Policies to describe where registry-based policy settings are stored in the registry.

**Microsoft Administrative Template XML-Based (ADMX):** The file type for XML based administrative template files that are used by Environment Manager Group Policies to describe where registry based policy settings are stored in the registry for Microsoft Windows Vista and Server 2008.

**Microsoft Application Virtualization (App-V):** An application virtualization and application streaming solution that allows application to be deployed in real-time to clients and virtual application servers. It was formerly known as Microsoft SoftGrid.

**MSI:** The filetype for a Microsoft Installer file, an installer file package format used by Windows.

**N**

**NetBIOS:** See Network Basic Input/Output System.

**Network Basic Input/Output System (NetBIOS):** A program that allows applications on different computers to communicate within a local area network (LAN).

**Network Connection Item:** In Application Manager, a network resource that can be added to a rule as an Allowed or Denied Item.


**node:** Application Manager and Performance Manager - A branch in the navigation tree in the product console. Environment Manager - In a configuration, a container that houses conditions and actions within triggers.

**NTFS:** See New Technology File System.
ODBC: See Open Database Connectivity.

Open Database Connectivity (ODBC): A standard software interface for accessing Database Management Systems (DBMS), making communication between applications and databases easier.

Open Software Description (OSD): A file format generated by App-V to define how an application is launched and configured.

Organizational unit: A container that holds users and computers in Active Directory.

OSD: See Open Software Description.

OU: See Organizational unit.

Personalization Analysis: An Environment Manager feature that monitors which applications are being controlled by Environment Manager, including how much data is being stored, and enables managers to convert discovered applications to UV Services and to roll back to Personalization restore points.

Personalization Group: A group of users, based on common requirements, that can be treated as a single entity for Environment Manager Personalization configuration. This allows group members to have the same managed applications, Application Groups, and user personalization settings.

Personalization Server: The server that acts as a broker between the client and database, providing a secure channel to read and write the Personalization data.

Personalization Virtualization Component (PVC): The component responsible for redirecting reads and writes of profile data from within a managed application.

Privilege Discovery: The Application Manager functionality to monitor endpoints in order to identify applications that use administrative privileges.

Process Rules: Application Manager rules that manage access for a parent process to run child processes that might be managed differently in other rules.

PVC: See Personalization Virtualization Component.
**R**

**registry hive:** A section of the registry that is a logical grouping of registry keys, subkeys and values. Registry hives are denoted by the prefix HKEY.

**regular expression:** An expression that describes or matches a set of strings. Regular expressions are usually used to give a concise description of a set without having to list all elements and to search and manipulate bodies of text based on certain patterns.

**Restricted:** The Security Level assigned to users, groups or devices in an Application Manager Privilege Discovery at which only authorized applications can run. These include files owned by members of the Trusted Owners list and files listed in Allowed Items, Trusted Vendors and Trusted Ownership.

**reusable condition:** A condition that can be used multiple times within a configuration, ideal for grouping common sets of conditions together that need to run regularly in a variety of circumstances.

**reusable node:** A node that can be used multiple times within a configuration, ideal for grouping common sets of actions together that need to run regularly in a variety of circumstances.

**S**

**Secure Hash Identifier (SHA-1):** A cryptographic hash function designed by the United States National Security Agency and a U.S. Federal Information Processing Standard published by the United States NIST. SHA-1 produces a 160-bit (20-byte) hash value known as a message digest. A SHA-1 hash value is typically rendered as a hexadecimal number, 40 digits long.

**Security Identifier SID:** A data structure of variable length that identifies user, group, and computer accounts. Every account on a network is issued a unique SID when the account is first created. Internal processes in Windows refer to an account’s SID rather than the account’s user or group name. Likewise, Application Manager also refers to a user or group SID unless the SID could not be found when added to the configuration.

**Security Level:** Application Manager configuration settings that specify how to manage requests to run unauthorized applications by the users, groups, or devices that a rule matches. Security levels include Restricted, Self-Authorizing, Audit only, and Unrestricted.

**Self Heal:** Environment Manager mechanism to automatically restore environment items, including files, processes, services, or registry keys.

**Self-Authorizing:** The Security Level at which the user, group, or device is granted control to choose whether to block or run an unauthorized application on the host computer. The Self-Authorizing Security Level can be assigned in an Application Manager Privilege Discovery to match a file execute request for users, groups, or devices.

**Server Configuration Portal (SCP):** A utility for configuring AppSense servers and databases. During product installation it is used to create server instances, databases and user accounts but can be used at any time for maintenance and troubleshooting.

**SHA-1:** See Secure Hash Identifier.

**SHA-256:** A hash function computed with 32-bit words. See also: SHA-1 and Adler-32.

**SID:** See Security Identifier.
Site: In Environment Manager, a logical grouping of clients and Personalization Servers communicating with a database.


Time Limits: Settings applied to entries in the Allowed Items and Denied Items nodes of an Application Manager Privilege Discovery that determine day and time ranges when the controls apply. For example, an entry in the Denied Items node of a rule can restrict use of the local web browser to users except between the hours of 12pm and 2pm on specific days of the week.

Transmission Control Protocol (TCP): A standard that defines how to establish and maintain a network conversation via which application programs can exchange data. TCP works with the Internet Protocol (IP), which defines how computers send packets of data to each other.

trigger: Preset User and Computer events that trigger actions and conditions.

Trusted Applications: Files that are authorized to run by an Application Manager configuration and can execute files that are normally prohibited. Trusted Applications are designated in the Default Rules and include specified Trusted Content, which includes files normally prohibited but allowed when run executed as a child process of the associated Trusted Application. Application matching takes place when a file is prohibited by a rule or fails Trusted Ownership checking.

Trusted Ownership: A secure method Application Manager uses to prevent users running unauthorized applications. On NTFS formatted drives, files have owners and Application Manager is configured by default to only allow files to be executed if the file owner is a member of the Trusted Owners list. If a user tries to run a file that is not owned by a trusted owner, the execute request is denied and a message notifies the user.

Trusted Vendors: Digital certificates signed by trusted sources. In Application Manager, Trusted Vendor checking allows applications that fail Trusted Ownership checking to match digital certificates with the Trusted Vendors list. A list of Trusted Vendors can be defined for each User, Group, Device, Custom, Scripted, and Process rule of the configuration. DesktopNow queries each file execution that fails Trusted Ownership checking to detect the presence of a digital certificate. If the file has a digital certificate that is signed by a certificate authority matching a valid entry in the Trusted Vendor list, the file is allowed to run.
UNC: See Universal Naming Convention.

Universal Naming Convention (UNC): A NetBIOS naming format for identifying the location of servers, printers, and other resources on a local area network (LAN). UNC begins with two backslashes (\) and takes the form: `\Computer_name\Share_name`

Unrestricted: The Security Level assigned to users, groups or devices in an Application Manager Privilege Discovery at which all actions are permitted without event logging or auditing.

User Personalization: In Environment Manager, the ability to capture application and desktop changes on a central database and reapply saved settings for users when triggered, such as at logon or application start.

User Privileges Management: An Application Manager feature that provides a granular approach to delegating administrative rights to users and applications by assigning rights according to merit. This level of control can be deployed to elevate or restrict privileges on a case by case basis according to the preferred approach taken in the environment.

User Virtualization (UV): The independent management of all aspects of the user on the desktop. The user’s personality is decoupled from the operating system and applications managed independently and applied to a desktop as needed without using scripting, group policies, or user profiles, regardless of how the desktop is delivered.

UV: See User Virtualization.

UV Service: The NT Service that is responsible for managing user virtualization on the endpoint. Stopping this service will prevent the endpoint from being managed by Environment Manager.

VDI: See Virtual Desktop Infrastructure.

Virtual Desktop Infrastructure (VDI): The server computing model enabling desktop virtualization, encompassing the hardware and software systems required to support the virtualized environment.

WMI: See Windows Management Instrumentation.

Windows Management Instrumentation (WMI): A set of extensions to the Windows Driver Model that provides an operating system interface through which instrumented components can provide information and notification.

Windows Script Host (WSH): The file format for Windows Script Host, an automation technology for Windows that provides language-independent scripting abilities similar to batch files, and is used to create logon scripts, automation, and batch files.

WMI: See Windows Management Instrumentation.

WSH: See Windows Script Host.